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1. Getting started in SpEd Forms

SpEd Forms allows access to up-to-date due process farmsifry computer with internet access.
The completed forms can also be printed from any compierspecial software needs to be installed
on the computer.

Student information is stored on the SpEd Forms sefl/lee. SpEd Forms administrator controls
access to the server and IEP managers control @ccstsglent records. There is no need for you to
backup information on a disk because all backups are perforntegdxy Forms.

1.1 Configuring your computer

Internet Explorer is recommended for Windows operatystesns. For Mac OS X users, we
recommend Opera. If you use Mac OS, please refer tldel est Results page at:
http://spedforms.com/support/mac_test_results.htm.

1.1.1 Instructions for Windows user§Recommended: Internet Explorer)
Download the latest version of Internet Exploreratww. microsoft.com

Step 1 Editing setup

1. Open Internet Explorer.

2. Select "Internet Options” from the "Tools” menu.| lirm = e oo, ond ned

3. Inthe "Browsing History" section (IE 6: Pt viewing B S
"Temporary Internet Files"), click "Settings". NlEr R e —

4. Under "Check for newer versions of stored page 8?:“'”;_“9;Etaf”“temetﬁxp'mf
click "Every visit to the page". Click "OK". Oneer

5. Select the "Security" tab and click on the "Custor Dk space 0 o 6 0211E)
Level..." button. Corrent ncaton:

6. In the "Miscellaneous" section - enable "Display CDccumants and Setings{uner.oce setangs| Tanporary
Mixed Content" (When you click "OK" you will be

asked if you want to change the security settings| [ ueefoer.. J[ vewdiecs ][ ewfies

Jemporary Internet Files and|Hlistory Settings

This is to prevent a warning box from being s

dISp|ayed |n "DeSIgn MOde", |t haS nOthIng to do gfpf\.cggs::g?yn;f,ngae?:isli?;edr,mt Explorer should save the list
Wlth the SeCUI'Ity Of yOUf Computer See NOTE Days to keep pages in history:
below.)

[ QK ] [ Cancel ]

NOTE: If you do not enable "Display Mixed
Content" a warning box will be displayed every time yse "Design Mode" in ER Forms.

Step 2: Printing setup

1. Select "Page Setup" from the "File" menu.

2. Delete any characters in the box labeled "Header".

3. Delete any characters in the box labeled "Footer".

4. Inthe "Margins" section, change all margins to ".6lick "OK".



Step 3: Printing background images

1. Select "Internet Options" from the "Tools" menu.

2. Click on the "Advanced" tab.

3. Inthe "Settings" section, scroll down to "Printing".

4. Make sure there is a check in the "Print background
colors and images" check box.

Click the "Apply" button and then click "OK".

o

NOTE: If you do not enable the option for printing

background images, the "DRAFT" image will not appe

in the background of your printed IEP when the
"DRAFT" option has been chosen.

?x

General | Security | Privacy | Content | Connections | Programs Advanced

Internet Options

Settings
= Printing A~
Prink background colors and images
- Search from the Address bar
(%) Do not search from the Address har
) ust display the results in the main window
ﬁ Security
[J allows active content from CDs ko run on My Computer®
[] allow active conkent: ko run in files on My Computer
[ allow software to run or install even if the signature is inv.
Check For publisher's certificate revocation
[] check for server certificate revacation®
heck For signatures on downloaded programs
[] Do not save encrypted pages to disk
[ Empty Temporary Inkernet Files folder when browser is clc ¥

4

;*Takes effect after vou restark Internet Exﬁ\urer

Restore advanced settings

‘¥ou should only use this if your browser is in an unusable state.

Reset Internet Explorer settings

Deletes all temporary files, disables browser
add-ons, and resets all the changed settings.

OK ][ Cancel ][ Apply

1.1.2 "Opera" Setup Instructions for Mac OS X user§Recommended)

Download the latest version of Opera http://www.opera.com

Step 1: Editing setup
1. Open Opera.

Preferences

2. Select "Preferences..." from the "Opera" mei
3. In"Advanced" settings, click on "Cookies"
and make sure "Accept Cookies" is selected

Tabs
Browsing
Notifications

" Ceneral ~ Wand = Search = Web Pages Advanced]

| Remember visited addresses for history and autocompletion
500 F

¥ Remember content on visited pages

Addresses Clear

4. In"Advanced" settings, click on "History” anc| o, S ot et
update the following. w = = jj] =
Set "Memory cache" tOff T = Emptyon exit
Set "Disk cache" t®ff S TaE
Set "Check documents” fiiway’s . oo _
Set "Check Images" talways = e
5. Make sure to click "OK" when you are e e
finished making changes.
Step 2: Printing setup
1. When you are ready to print a form, select "Ptiratin the "File" menu.
2. Select "Opera" from the drop down menu
currently labeled "Copies & Pages". frst
"Print Background" should be checked | g ™ 2= :f}
"Print Headers and Footers" should be /o — =
UnCheCked As... # Print Background
3. Select "Save As..." from the "Presets" drop e
down list Gelect "Save[as shown in inset]f you @ o ¢ — )

already have a "Default" preget
4. After you have made these choices, click on

"Print" (these last steps may not be saved if you do not follow through withnhenocess



1.1.3 "Firefox 3" Setup Instructions for Mac OS X users

Download the latest version of Firefox 3 &ttp://www.mozilla.com/en-US/firefox

Step 1: Editing setup
1. Open Firefox 3.

8e6n Advanced

2. Select "Preferences"” from the "Firefox" menu.

3. In"Advanced" settings, select the "Network" tab
and in the Cache section change the value to 0
(zero) for "Use up to O MB of space for the cache
In "Advanced" settings, select the "Update” tab a
uncheck all boxes (when Firefox is set to
automatically update, crucial settings can be lost
5. Close the Preferences window.

Step 2: Printing setup
1. When you are ready to print a form, select "Prin

@ B s &

Main Tabs Content Feeds Privacy Security | Advanced

)3

[ General ]} Network 1[ Update | Encryption |

Connection

( Settings... )

Configure how Firefox connects to the Internet
Cache

( Clear Now )

Useupto O MB of space for the cache

@

Print

from the "File" menu.

Select "Firefox" from the drop down menu
currently labeled "Copies & Pages".

In the "Page Headers" &amp; "Page Footers"
sections change all drop down list to "(Blank)".
Select "Save As..." from the "Presets" drop dow
list (select "Save[as shown in insetjf you already
have a "Default" presgt

2.

standard
Default

Save

Printer: | Brother

Presets: | Default

| [as] [<»

Firefox

: ™ Shrink To Fit Page Width

: ) Print Background Colors
E Print Background Images

Page Headers: | %) [ ®lank) =]
Right

%) (®ank 15)

(Blank)
Left
(Blank)

%) [islank)
Center
%) [®lanky

Page Footers:

PDF v ) ( Preview ) ( Supplies... )

(G

After you have made these choices, click on

"Print" (these last steps may not be saved if you do not follow through withnhenocess

Setting Margins in Firefox 3

1. Select "Page Setup" from the "File" menu.

2. Next to "Paper Size", select "Manage Custom
Sizes...".

Click the "+" sign toward the bottom left of the
"Custom Page Sizes" window (this will add a
page called "Untitled", double click "Untitled"
and you can type in a new name, e.g. "SpEd

3.

Forms").

Select this new "Page Size" by clicking once ot —
it's name (it should be highlighted, blue).
Set the width: 8.50, Height: 11.00 and make sure

Orientation:

Page Setup
Settings: | Page A 8enn Custom Page Sizes

EFETEN | oo size:

11.00 in
Height

8.50in

Format for: | Any Pq
— Width

Printer Margins

"SpEd F
8.50in

Paper Size:
User defined

[ )

0.50 in
Top

s

100 %

0.50 in
Right

0.50 in

i 0.50 in

Bottom

Scale:

| + | = | Duplicate

Printer Margins is "User Defined". Set all marginghe recommended 0.50 inches.

and Click "OK" for the "Page Setup" window.

Click "OK" and make sure the new custom size youdtesited is selected next to "Paper Size"



1.2 Accessing SpEd Forms

You will receive a server address,
username, and password from your SpE@ SpEd Forms
Forms administrator. Keep this
information safe, you will need to use it | maIN MENU Goto.
each time you log on to SpEd Forms. } Yoursetup 3 ] Work with students
throughout the program student information

1. Type the server address into the

"Address" box of your internet g | Your calendar ROPOMS v renorc
browser EEEEE \.lwa.rtame‘v'ems !

NOTE: You may want to o come sunes

"Bookmark” the login page so that|| = iz s e
you do not have tO entel’ |t each Rememberto turn in applications by this Friday!

Latest support infoermation from SpEd Forms.

[ on ieg in, 9o to work with students

time you access SpEd Forms.

2. You will be taken to a log in screen where you canrgotigr username and password.

3. Click "Enter" and the SpEd Forms main menu will appear.

4. Take note of any new messages you may have. If laetelags requested access to a particular
student (see section 2.2.5 for more information), youtake care of this task and then delete
their request by clicking on the "Delete" link next to tadry (also see section 2.2.6).

1.3 Changing your user profile
S SpEd Forms
Your user profile is initially set-up by the
SpEd Forms administrator for your Your setup
district. You can change some of this 1. profie 22, conte
profile information or add information ET— EPR—
that the adminiStrator dld not enter. =] 5. credentials =] 6. commonly used Materials and Procedures

_J 7. Edit drop down lists

1. Navigate to the "Main Menu".
2. Click on the "Your Setup" button. e
3. On the "Your Setup” menu, click

on "Profile".
4. On this page you will notice the CS: SpEd Forms K =
information that your SpEd Forms
administrator had entered. Your setup
5. Make the necessary changes and First[Some Last [Teacher
type in any new information. DI;:'; Zﬂb'E:Thlh
6. Click the "Save" button when you B rrr——
are finished making changes. Location/Agency: Brisbane Elementary

Phone: 612-555-1234 Fax: |612-555-1235
Email:| some teacher@hostcom
User Mame:|teacher
Password: (uinimum &) eesesss Confirm: |essssss
Print Font Size:*| 12px Show "Save" Wamnings
Default MA Service:| —Select Service—

Default view:| Main menu

* Approximate size only. Results vary depanding upon brovesarprintes




1.4 Managing your custom goal bank

Each SpEd Forms user has their own custom goal bank.cafoAdd, Edit or View your custom goals
through the "Goals" menu in "Your Setup”. When you enistamm goals they will be available on
any goal page when you click on "Choose Goal" and therifggbty Goal Bank™" as the goal bank.

To navigate to your custom goal bank:

1. Navigate to the "Main Menu".
2. Click on the "Your Setup" button.
3. On the "Your Setup” menu, click on "Goals".

To Add a new goal: t MY GOAL BANK . .
1 Cl k "Add G I,, f th Add Goal Save wenu | B My Goal Bark | @ My Goal List [§ add |
. ICK On oal” from the
"My Goal Bank™" menu. EDIT YOUR GOAL
" " Category: | Early Childhood Subcategory, | —Select Subcategory—
2. Choose a "Category" and then a | s —Selor U
"Subcategory" (subcategories will | ™ = = Comnve
change when the category is Fyscelinsiore
Ch&ﬂgEd). Objetives Social/Emotional

3. Fillinthe "Goal" and add as man: | " » susten eieccive

"Objectives" as necessary.
NOTE: Use the letter combination __
CHLD in place of the student's
name. When you import one of these goals into yourggaze the letter combination "CHLD"
will be automatically replaced with the student's firstme.

4. Click the "Save" button when you are finished makingghas.

To Edit an existing goal:

1. Click on "My Goal List" from the "My Goal Bank" ma. The "Goal List" shows all of the
custom goals you have entered.

2. Click on the "Edit" button next to the goal you wantipdate.

3. Update the goal where necessary
by changing the category,

subcategory, goal or objectives t B g PANK e [ @ o [ @ |
(you can also add/delete
objectives). e

4. Click on the "Save" button when ..

you are finished making changes. s csomsa

To Delete an existing goal:

1. Click on "My Goal List" from the "My Goal Bank"” ma. The "Goal List" shows all of the
custom goals you have entered.

2. Click on the "Delete" button next to the goal yountna delete.

3. The goal will be deleted and the list will be refreshe



1.5 Your custom measures bank

Enter commonly used measures into your custom measurks bhese measures can be used to keep
track of and graph the progress of any goal or objective.

To Navigate to your custom measures bank:

1. Navigate to the Main Menu. :
CS: save | [4 Back |EE] Meru [ out | B ean |

2. Click on the "Your Setup" button. SpEd Forms
3. On the "Your Setup” menu, click
on "Measures".

Gaoto..

Edit Your Measures List

To Add a new measure: ian e Rems
Math 100 O

1. Enter the measure's name and ni Reading O
score in the blank spaces providg Word Analysis % O

next to the word "(Add)".
2. The new measure(s) will be addg

once the page is "Saved" (more
blank spaces will also be added).

To Edit an existing measure:

1. Make changes to any of the existing values as needed.
2. Changes to the measure(s) will be saved once the p&peved".

To Remove an existing measure:

1. Put a check in the (Remove) checkbox next to the meegsurwish to remove.
2. The measure(s) will be removed when the page is "Saved".



1.6 Your custom team member list

Enter commonly used team members into your custom teamber list. Once entered into the list
you will be able to quickly and easily add them to the te@mbers sections of forms such as the IEP
and the "Notice of a Team Meeting" without re-entgtine team member name and title.

To Navigate to your custom team member list:

1. Navigate to the Main Menu.
2. Click on the "Your Setup" button. CS: SpEd Forms e | (A oo [El v [ o | B ]
3. On the "Your Setup” menu, click

on "Team Member List".

Edit Your Custom Team Member List

To Add a new team member:
. . Kelli Bymes Office Manager ¥

1. Enter the team member's first chane . broadont -
name, last name and title in the Mike Hellie Programmer O

blank spaces provided next to thg | v Levis Consuant 0

WOfd "(Add)". Amber Sanow Production Manager ¥

2. The new team member(s) will be
added once the page is
"Saved" (more blank spaces will
also be added).

To Edit an existing team member:

1. Make changes to any of the existing values as needed.
2. Changes to the team member(s) will be saved once geegpSaved".

To Remove an existing team member:

1. Put a check in the (Remove) checkbox next to the teamber you wish to remove.
2. The team member(s) will be removed when the pageaigets.



1.7 Your custom credentials

Keep track of your education license information, it'shatical code and expiration date.

To Navigate to your custom credentials:

1.
2.
3.

To Add a new credential:
1.

Navigate to the Main Menu.
Click on the "Your Setup" button.
On the "Your Setup" menu, click
on "Credentials".

Enter the name, number and
expiration date in the blank space
provided next to the word "(Add)"
The new credential(s) will be
added once the page is

"Saved" (more blank spaces will

(| spEd Forms

MDE onling license information

E save | [4 ack |E venu [ out | (B eent |

Cradentisl
Adult Basic Education (Adult)
Agricultural Education (Grades 5-12)
Business (Grades 5-12)
Technology (Grades 5-12)

---Select Credential---

-—-Select Credential—-

---3elect Credential---

Edit Credentials

Number

100250
204528
168422
108993

s[> [0
]

lf30
130
lf30
130

[f2010
{2009
{2011
{2008

Remove

also be added).

To Edit an existing credential:

1. Make changes to any of the existing values as needed.
2. Changes to the credential(s) will be saved once theipd8aved".

To Remove an existing credential:

1. Put a check in the (Remove) checkbox next to the diatlgou wish to remove.

2. The credential(s) will be removed when the pageaség".




1.8 Your custom materials and procedures

Once your commonly used materials, procedures and evalaatoestered into SpEd Forms you can
attach them to any "Notice of an Educational Evalu#®ervaluation Plan" without retyping.

To Navigate to your custom materials and procedures:

1. Navigate to the Main Menu.
2. Click on the "Your Setup" button.
3. On the "Your Setup” menu, click

E save | [4 ack |E venu [ out | (B eent |

(| spEd Forms

on "Commonly used Materials an
Procedures".

To Add new materials and procedures:

1. Enter the evaluation area,
materials/procedures and
evaluators in the blank spaces
provided next to the word "(Add)"

NOTE: If the area you need is nof]
listed in the area list, type it undel

Edit Your Custom Materials, Procedures and Evaluators List

Academic Performance Historical Texts

Ewalustion Ares Ists

Other Area;|

Intellectual Functioning

—Select Area—

Other Area;|

"Other Area".

added).

To Edit existing materials and procedures:

The new custom area(s) will be added once the pa§aved" (more blank spaces will also be

1. Make changes to any of the existing values as needed.

2. Changes to the custom area(s) will

be saved oncegeagp&Saved".

To Remove existing materials and procedures:

1. Put a check in the (Remove) checkbox next to the custeanyou wish to remove.
2. The custom area(s) will be removed when the padgaget”.




1.9 Your drop down lists

Most of the drop down lists in SpEd Forms can be manhgékde super administrator. The super
administrator can also choose to allow users atoesdit
any of these lists. When you are allowed to add to a C

specific drop down list, a link will be provided on this
page. When you add entries to a specific category, tho
additional entries will be available throughout SpEd For
but will only be available to you. No other teacher bl

SpEd FOI'mS 4 Back Meru

Drop Down Lists

Form(s) |Field Hame

able to see your additional entries nor will they be &dle WA |ACTIATYLOG DESGRPTIONS
manage them All COLTSES OF StTUE?‘r‘
NOTE: In the inset (to the right) notice | SPEd Forms e = | S
the additional choices added to this user
drop down list for "Course to be taken". Edit Drop Down List
To Navigate to your drop down lists: o
1. Navigate to the Main Menu. Spanish: [ ~Select -
2. Click on the "Your Setup" button. | se= vsus e
3. Onthe "Your Setup" menu, click || 7 Redre ':;:’“ad'"g 0
on "Edit drop down lists". T —— -
[P
. - Course to be taken
To Add to a specific drop down list: 5| [atmetc 7 (YT [ emrmprmrm——r— 1
. J5E :
1. Enter the order, value and display = Eecho
in the blank spaces provided nex{ ul et
to the word "(Add)". gj s -
5P
NOTE: The "Value" is what is

saved into the SpEd Forms

database. Sometimes the value needs to conform to &csfaonat (a number, no more than
two characters, must match what is in Display, etelease contact your SpEd Forms
administrator if you need additional assistance detenqgitiie value setting.

2. The new drop down list entries will be added onceplge is "Saved" (more blank spaces will
also be added).

To Edit existing drop down lists:

1. Make changes to any of the existing values as needed.
2. Changes to the drop down lists will be saved once tipe ipdSaved".

To Remove existing drop down list entries:

1. Put a check in the (Remove) checkbox next to the dram dist entry(s) you wish to remove.
2. The drop down list entry(s) will be removed whea plage is "Saved".



1.10 Your custom calendar

On your calendar page you will automatically be notifiethgfortant dates for any student that is
shared to your account and special events that are sothdyudelministrators. If the proper dates are

entered for each student, their IEP date,

IEP meeting date, IEP due date and
evaluation due date will be shown on yo
calendar. You can also add events to y(
calendar to remind you and other team
members of important dates.

To Navigate to your calendar:

1. Navigate to the "Main Menu".

2. Click on the "Calendar" button.

3. You can click on the arrows next
to the month/year to go forward o
back to a particular month.

To Add events to your calendar:

1. Navigate to your "Calendar".
2. Find the correct month (click on
the arrows next to the month/yeat

&

SpEd Forms

== September, 2006 ==

Sunday

R
L

Moanday Tuesday Wednesday Thursday

1 Add 2

Add 4
3:45.0
Teachers Mesting

Some Student
IEP meeting,

Saturday

to go forward or back to a
particular month).

3. Click on the "Add" link next to the date for whicl

you want to add an event.

Calendar EET|
Add Event
Add ewvent for 9/21/2006:
Date |9 f21 fzooe  |E

Time|s 30 0
Student | Student Some

Share event with team members

Phd

Choose the student's name and fill in any other
pertinent information. Uncheck the "Share even
with team members" if this is a personal event.

NOTE: The "Time" and "Title" will be displayed
on your calendar. The "Title" will appear as a lir

and you can click on this link to delete or make

Title | Tom's blood test

Location clinic

Description |5ring Tom to

the

clinic for a blood

test.

Delete Event

changes to this event.

5. Click on the "Save" button to save your changes.

To Edit events on your calendar:

1. Click on the link to a specific event that you or art@aember has created.

2. Make any necessary changes.

3. Click on the "Save" button to save your changes.

To Delete events on your calendar:

1. Click on the link to a specific event that you or art@aember has created.
2. Click on the "Delete Event" button.

11



2. Working with students

NOTE: Give special attention to saving, printing and navigaitistructions:
- Always click the "Save" button after information idemred or changes are made.
- Always use the SpEd Forms "Print" button, instead otsalg "Print" in the "File" menu.
- Always use the SpEd Forms "Back" button rather thatoeser's "Back" feature.

2.1 Setting up your students

Only IEP managers or others assigned the correct aytbgryour SpEd Forms administrator may
create new student records.

2.1.1 Add a new student @ SpEd Forms
. . " Woerk with students
1' NaVlgate to the "Maln Menu . Show: | students served by Brisbane Schools
2_ C“Ck on "WOI'k Wlth Students" [ Adcllj Sh-];: :aEil'v'e\'e]xlnedpstulilelnst c||:| Itﬂ'—‘Elll[;uhh;\stunemts;tm(:| t ]
. . new studen Ickup studen egues! Luden

3 You WI” then see a “St Of a” your Status  Student ID Name Eval. Consent |Eval Writien |IEP Daie
students (ShOWﬂ with a plnk © 1234567800123 Some Student |@1/10/2004 @ 1/152004 @ 0/8/2006
background) and those that other| ©  '¢72s60147 Tesistdent | @owi2003  @9/1212003 |@5/15/2008

IEP managers have shared with
you (shown with an ivory background).

4. Click on the "Add New Student" button to add a student ¢k oln the "Pickup Student" button
to obtain the record for a student that is on anoth&dS3-orms server (see section 2.2.4).

NOTE: If this screen does not s T —
haVe the "Add NeW Student" Status End (ExitReason): | --Select Status Change/Exit Reasan--
manager or you have not been  p— p——
given access to create new stude| ....c.r.. OF OuF OFs ol coneont
records. Contact your SpEd SiudentMARSS ID eal witer
Forms administrator if you feel| | sedesecuivio: Previous IEF
your status needs to be changed. ™" " g
Serving District —~-Select District-—- RI:;::aiam o :
5. Fill in any known information on | swngseroa ~SelectSchaol - £l Lot )
the Setup page Resident District: ~Select District—- Other MAENgible [INe [Jves
6. Click the "Save" button. RQC‘E”' ot e Lovel e D D
7. The student will now be added to| ... g
the list. B,
Native Language ~-SelectLanguage--
. Federal Setting: -Select- ESV JulAugust
NOTE: Status, Student/MARSS ID, First| = senie Stat
Name, Last Name and Serving District & sinouaiea progem 0 Senice End: i
required. A

Parent/Guardian Name:
Home Phone: Work Phone:

You can click on any of the drop down
boxes to see a list of choices.

Address:

Click on any link to get a more detailed description. Tilefor the "Federal Setting" will take you to
12 a list of settings and descriptions of settings forotegiages. You will need to close this new window
and choose the setting number from the choices idrd@down box.



2.2 Student setup

Besides administrators with edit privileges, only IERhaggers and those with edit access may edit the
student's setup or exit a student from SpEd Forms.

NOTE: On the "Form Menu", shared students will haview case manager | Remove from my list"
displayed under the student's name. Use these links tovRearstudent from your caseload or view
information about the case manager.

Status SpEd: Evaluated: Receiving special education services [4]
" Status End (Exit Reason): | --Select Status Change/Exit Reason-—
2.2.1 Editing student setugyou must manyDisanity: | Desthard ohesng
have edlt access tO thIS Student) Administrator note: Mo administrator note entered.
Demographics Special education
1. From the "Maln Menu" C“Ck on E-er,lce Flan - @R CuP OIF?P (@) Eval. consent: 1 n 2002 2@
"Work with students". o e
2. Click on the_ student's name or th{_ ., ... Some . T Ve 5 e
"Work on this record" button. Last Name Student annualteammesting 7 |1 |[z000 |m
3. Onthe "Form Menu" click on the | serving oistrict Brisbane Schools Reterral: 3 23 2007 |z
"Ed't Setup" button Semning Sch.cc\ Eh?sbaneE\ememaly d Eval. Hours 13
4 M k h d d d | Resident District: Brisbane Schools Other WAElgible [lne [ves
. ake C angeS as neededa an Cli Regular Ed. Teacher: |RegEd Teacher WMCA Accomadations  [PNa [ves
on the "Save" button.
5. C“Ck "FOI’m Menull tO return to Birthdate: 10 9 1996 |E Reqular school vear: |10 [ Calculste ]
the form menu for this student. |7 2t svane 73
Federal Sefiing: 0 ESY Jublauust:  [14.3
NOTE: The "MARSS" button will | stresen e R
ilingual rogram  [@ Service End: 12 Kl 2006 |@
only show up for those students that |22
have a MARSS compliant Student/ [
MARSS ID (no more than 13-digits). | semeparen Home Phane: (507)555-1234 | ork Phone: |(507) 5555678
Address:| 123 Parent Address Parent City L IMN 56123
2.2.2 Student sharingcase managers
only)
S SpEd Forms ZI T T

1. From the "Main Menu" click on
" . " SHARING FOR SOME STUDENT
Work Wlth StUdentS . Select a user Users with access to this student
2. Click on the student's name or th———- =iz,

" H n w (iEm DEmeae) Some Teacher, Edit Aceess
Work on this record bgtton. T
3. On the "Form Menu" click on the
" H n SEND THIS STUDENT TO A NEW IEP MANAGER
StUdent Sharlng bUtton [ Send this student to a new case manager ]

4. You will be taken to a page
showing users with access to that

student and the users which are available.

Click on the "Select a User" drop down box.

Select a category or "View All" and a screen wplpear listing all available users.

Select the desired user by clicking the "Share" buigot to that person's name.

The user's name will then appear in the list on gie.ri

If this user should be able to edit the forms, cliek"tadit Access" box. If the box is not
checked, the user will have read only access.

10. To remove a user from the list, click on the "Unshhutton to the left of that person's name.

©oNOO

NOTE: "(Case Manager)" will appear next to your name (daembve your "Edit Access").
Clicking on the link to a users name will display a spafffile information box. Their name, title,13
location, phone, fax and email will be shown (if tim®rmation is available in their record).



2.2.3 Send the student to a new IEP_managérase managers only)

1. From the "Main Menu" click on
"Work with students".
2. Click on the student's name or th

S pEd F orms [ setect another student | FormMenc [E2) menu [ auit |

SEND SOME STUDENT TO A LOCAL® CASE MANAGER

"Work on this record" button. | Select ihe Case Mianager

3. On the "Form Menu" ClICk On the Uniess reset, the current case H’.E“’.EQ‘E"{TE&C"?E" Some) will continue to have shared edit access to this student
"StUdent Sha‘rlng" bUtton --Select a local IEP manager-—-

4. Click on the "Send this student toff Dreset current student sharing

" o " . . sor ftypically v . . el
a new case manager button local" IEP Managers share your server (typically within your district or senvice cooperative

SEND SOME STUDENT TO A REMOTE* |IEP MANAGER
1. Fill out the information below

2.2.3.1 Send student to a local managerj; 2o oo e e e e

4. Print the fax cover sheet and fax it to the remote |[EP manager

Click here for a list of SpEd Forms school districts and charier schools

Most charter schools and cooperatives Qo Frone humber

easily reassign IEP managers via the logfj&zes1z+
Remote IEP Manager Mame:
method.

Remote [EP Manager Fax Number:

1. Navigate to the "New Case
I\/Ianagel’" screen (SeCtion 223) ** "remote” [EP managers use another SpEd Forms semver (typically outside your district or serice cooparative
2. Inthe top box labeledsEND
[STUDENT]TO A LOCAL IEP MANAGER", click the drop down box to see all available managers
3. Scroll down until the correct name is displayed aiul cn the name.
4. Click "Send" to send the student to that IEP manaf@goylno longer need to have access to
this student, put a check in the box labeled "Reset dwstedent sharing”).

NOTE: After a new IEP manager is assigned, only the newnlBRager can set student sharing.

2.2.3.2 Send student to a remote manager

If the student is moving to a school/district outside

. . . . . Brishane Schools
your district or service cooperative and their SpEd 101 Brishane Lane A
Forms web address is different from yours, the ney e ey
school can use the "Pickup Student” feature to
securely obtain the student's current information. | |5 rexser o reacher (Tel 612 555.1234)
Fax #: Re:
1. Navigate to the "New Case Manager” screg fm—"—" oo
(section 2.2.3). 1 10/24/2006

2. In the bottom box labele&$END [STUDENT]
TO A REMOTE IEP MANAGER", fill in your
phone number, the new IEP manager's nan
& the new IEP manager's (10 digit) fax
num ber_ PICKUP INSTRUCTIONS:

3. Click on the "Create Fax" button (this will
create a faxable cover sheet with informatio
that the remote IEP manager will need to
pickup this student).

4. Print this page and fax it to the new IEP
manager.

Student data for Some Student iz ready for vou to pickup.
COMPUTER BEQUIREMENTS:

+ IpEd Forms Internet Edition

. Logmto 3pEd Forms

Click on "Student Setup”

Seroll down to "Pick up a transfer student”

Enter server address: https://spedformns.org/mnl234
Enter pickup code: ABCDEFGH123456789

[ T

14 NOTE: This procedure is used to inform the school of your sexddress and create the pickup
code they will use to import the data. The student esfiain on your system until they are exited.



2.2.4 Pickup a student @ SpEd Forms BT (Y

1. From the "Main Menu" click on PICKUP STUDENT - STEP 1
"Work with students”. Server Aduress: | hitos/10.spedioms argf1234
2. Click the "PiCkUp Student" button Fickup Code: | ABCDEFGH1 23456763 e _out
3. Fillin the server address and
pICkup COde |ISted On the fax you oo SR T T e You are requesting Another Student (ID# 0123456789).
received from the remote school o e orpo g || e SUAE 6 15 i pedroms
district and click "Next". R e B e rer—
4. Create the new record. If you are - Vo0 il be e 58 manager nless anciherls chasen
given the option to "Update" the | I —Selectanother case managar -

record, be advised that this will
replace all current information with that from thenae server (if recent changes have been
made to this student's record, those changes may be lost).

NOTE: If the server address and/or pickup code were typedrextty, you may get a message stating
such and be given an opportunity to "Try Again". Ensurenfdkimation is correct (must be a secure
server address, "https://..."). If you continue to get tessage, the pickup code may have expired.
Contact your SpEd Forms administrator.

2.2.5 Request access to a student s bt e i

Plasss entes the First and Last name of the studant you are raguesting acoess to

First Name: | Some

1. From the "Main Menu" click on
"Work with students".

2. Click the "Request Student"
button.

Last Name: | Student

1 Student(s) Found

[4 Back B werw [ ou |

T e |

3. Fill in the first and last name of 1234567690123 | @ Student, Some | Teacher, Some Goto
the child you want access to and
click on the "Next>>" button. L1 | A message has been sent to Teacher, Some stating that you have requested access to Some Student.
4. A list of students will appear that
match the name that you entered| |E
Click on the "Request"” button nex |
to the student you want access tq | o Bl il
5. A confirmation will then appear, || [Zieiss sper poepesossr
confirming that a message has Rememberto fum in 2ppications bt e
been sent to the teacher. La‘**“;"’_"fti“iij"i‘jatf‘f‘jffff_:lif"i:""‘“s'

2.2.6 Managing the "Messages Inbox"

The "Messages Inbox" appears toward the bottom of the Manu. You can check your messages at
any time by navigating to the "Main Menu". If a requestdocess appears in your massages, you can
navigate to the "Student Sharing" page for that studensés#in 2.2.2 for more information), add
sharing for the sender (if appropriate) and then "Detbia"entry from your messages.

15



2.2.7 Exit a student(you must have edit access to this student)

" M n .
1. From the "Main Menu" click on Status EXIT: SpEd: [EP/IFSP/IIP was terminated in this school year [7]
"WO rk W|th Students" Status End (Exit Reasen). | —Select Status Change/Exit Reason-—
. Primary Disability
2_ C||Ck on the Studentls name or th _”malj' el 50: Special Ed. data change (eg: Eval. Status, Fed. Set, Disability)
"W k th . d" b tt Administrator note: 99: Student enrollment status change (eg: enrolled in Special Ed.)
r n IST I n. DD: Used for fall reporting unless studentwithdrew priar,
O h 0" S eCO " |u ko h Demographics 01: Change in student grade level -
r s 02: Transferred to another public school in the same district. -
3' On t e Form Menu C IC On t e Senice Flan ®rr O EXIT 03: Transferred to an approved nonpublic schoal. @
" I " Student/MARSS 1D 123456789|EXIT 04: Student moved outside ofthe district. -
Ed It Setu p bUtto n. EXIT 05: Student moved outside ofthe state or country. e
n n Social Security 1D 123456789EXIT 06: Student left after compulsory attendance age wjout election =
4' SeIeCt a‘ neW Status and/or Eirst Hame Some EXIT 07: Student left after compulsory attendance age w/ election @
" T n . = EXIT 08: Student graduated (does notinclude IEP/IFSP/IIP graduates) E
Status End (EXIt Reaso n) . ast Mame Student |EAIT 09: Student graduated after meeting IEP/IFSPAIIP requirements. -
H H H o B EXIT 11: Student died E
5' Update any pertlnent Informatlon Serving District Brisbane {EXIT 12: Student excused from attending for disability =
H n n EXIT 13: Student committed to a correctional facility. N
6. C“Ck on the Sa.ve button tO SaVy sering scnool Brisbane |ExT 14 Student withdrawn after 15 days consecutive days absence
Resident District Brisb EXIT 15: Student left school because of marage.
yOUI’ Changes FeiembIE sbane EXIT 16: Student expelled and did not retumn during the year.
RegularEd. Teacher: |RegEd TQEXIT 17 Student left school due to pregnancy.
Grade: . , F|EXIT 18: Student w/drew, no tran., or frans. to @ non-app. nonpub. schoal. £
. Grade Grade 4 EXIT 20: Student transferred to another district/state but did not move -
NOTE: You must choose either an Birhdate: 10 g |EXIT 21 Early Childhood witrdrawal: IFSP/IEP/IIP objectives met
" " " " EXIT 22: Student withdrew to enter a care and treatment center.
EXIT Status OR an EXIT Status End Gender: [ CIF|EXIT 23: Kindergarten withdrawal. expected back next year.
. . . Native Language English EXIT 24: Withdrew to receive homebound services
(EX't Reason) to Inactivate the Student ' 91N B EXIT 25 EC evaluation only, child not eligible for services
. . . ) Federal Setting; oM EXIT 26: EC withdrawal by parent
27-EC transition atage 3 =
The eXIted StUdent WI” then dlsappear ESL Program EXIT 31: Student left school for social reasons. =
from your list of active students. Bilngusl £4 Program SeicsEnd: 1231 _J[2006 =
- . . - ParentGuardian Name:
2 . 2 . 8 ReaCtlvate an InaCtlve/eXIted Some Parent Home Phone: (507) 555-1234 | work Phone: |(507) 555-5675
student (you must have edit access t0 th| .uuess 123Paen Addiess Parent City v [56123
student)

From the "Main Menu" click on "Work with students".

Make sure there is a check in the "Show inactivedé)students” checkbox.
Click on the student's name or the "Work on this @cutton.

On the "Form Menu" click on the "Edit Setup" button.

Select a new "Status" AND clear or choose a v&8tdtus End (Exit Reason)".
Click on the "Save" button to save your changes.

ok wnNpE

NOTE: Ensure that neither the Status nor the Status EntlReason) have an "EXIT" value (you
can choose "---Clear---" for the Status End (Exit Reaso clear out its value).



2.3 Working with student information

2.3.1 Your student list
S SpEd Forms

1. From the "Main Menu" click on
"Work with students".

Work with students

Show: | students served by Brisbane Schools

2_ A ||St of Students you have acces [ show inactive/exited students. [] 14 eligible students only
. [ Add new student H Pickup student H Request Student ]
to will appear. ;
Status  Student ID Name Eval. Consent |Eval Writien |IEP Daie
@] 1234567890123 |Some Student |@1/10/2004 @ 1/15/2004 @ 0/8/2006
NOTE: These are either students|| /@ 1472583600147 |TeslSdent | @0/2005 | @0/12:2003 |@5/15/2005

you have setup (shown with a pink
background) or ones assigned to you by another IEP managem(ghth an ivory
background).

3. To work with student information, click on the "Wornk this Record" button next to the
appropriate student. Your student list also provides younrdtion about important dates at a
glance. Green smiley faces indicate dates appeardntbeed correctly. Red and orange faces
indicate important dates have not been entered or ndededited/adjusted (for more
information, click on the appropriate face).

2.3.2 Navigate to forms

SpEd Forms v som s
1. From the "Main Menu" click on _
"Work Wlth StUdentS". Special Education | MA Forms " Stuueln:::a”ng IE Edltr:tﬂu:li‘lal Histor

2. Click on the "Work on this

Showing 2007-08 forms

Record" button next to the [0 St for ScresningEvatution Bt
appropriate student. [ Seteratneviswans [l meview of Extuting Dt
3. This will take you to the forms ) o ten e parontalconsent/ (5] 2] evtotion Report= it £ Frs drse

menu for that student. This menu
lists all the forms available in

|6 2] noti " [f§] Agreement Regarding IEP Team Member
I8] [2] Wotice of a Team Meating® New I SR e

SpEd Forms including the IEP, T T— S
IFSP, 1lIP, Evaluation Report and E
many other additional forms. il
4. To navigate to a form, click on thg . Additional Forms
form's name. You will be taken e Mmoo
either to the form or, in the case q | Jeerdimibrseditia.: | B aberton o cfinformaint
multiple-page forms, a listing of e g
the pages within that form. [ i bl I b peistons
[] [2] manifestation Determination* New [H] Behavior Intervention Plan* New
2 3.3 The forms menu (2] 2] o Process Hearing Reavest ot (] ] Parent Nekcton o rnstr i
[Bl performance Evaluation Area [ Smerostoyziectn
The forms menu lists all form [B] Extended School Year Service 6] Blank Pages/Additional Information
templates available in SpEd Forms. (2] pecial Education Data shest B s miedasment And Tuiion
Form templates which are replicates (1] summary of Performancs ] Complaint Farm® New

of forms posted on the Department g
Education web site are marked with
an "*". The other forms have been
developed over the years in conjunction with variousgkdistricts. If "Active" appears next to
the service plan, the student is currently on that p¥wu can change which form is "Active" by
clicking on "Edit Setup" and changing the "Service Plan". 17

* Based on a state recommended form




2.3.4 View/Delete a student's history

1.

2.

From the "Main Menu" click on ‘ | | |

" . " \ Select Another Student teru | i ouit
Work with students". _ SpEd Forms Working with Some Student
Click on the "Work on this e rr |

Record" button next tO the Special Education |MA Forms |E5L |504F|an |mstury
appropriate student. Date Filed | File Type Filed By

On the "Forms Menu" click the [ o750 mer mavzan o e Techer [ v | [Xese]
"History" tab. .~ ——
Find the history page or form thaf] ez, v pessens nerenenron oo 2

you want to view and click on the sezzr, - Baiey sever e resner [ELve | [Xosie]
"View" button. 5/3/2006  |Notice of a Team Meeting (2006/07) 482 —

R . 10:59:00 AM |(Rev. 9/1/2005) Some Teacher

You will 'then Come-tO a page with ?gagzﬁogg a ‘r'llqot;ll.cgllﬁlizuDU\EEricts Proposed Action or Denial (2006/07) ;Efﬁe ey Bt ] [oaste] [ |

the form's page(s) listed. Choose

the page(s) you want to view and P one 2007 13600 P

click on the "View Selected RS e

Please select the pages you wish view.

Pages" button.

Student Information

Section 1: Reason for Background Information Section 2: Information Reported by Parent(s)

NOTE: While VieWing these Section 3: Educational Evaluation Methods Section 4: Relevant Medical Findings
Selected pages yOU W||| have an Section 5 Summary of Special Considerations Section 6: Existing Data and Current Results
Oppo rtunity to print or navigate Section 7: Eligibility Determination Section 8: Present levels of Performance
back to the page IiSting, history Section 8 Conclusion R
page or forms menu. i i i

By [ ViewSelectedPages | Ooraft ©final

To delete a history page or form,
click on the "Delete" button next
the name of the history you want to delete.

NOTE: Administrators have the option of allowing users ton@nently delete history records
directly or to flag the deleted record for review by 8pEd Forms administrator. The warning
that appears when the "Delete" button is clicked shoulel ypw an indication of whether the
record will be "permanently” deleted or you "want thedmigto be deleted". If the record is
not "permanently" deleted, the SpEd Forms administmitbhave an opportunity to review
the record and make the final decision to delete the recaoekstore it to your list.

2.3.5 Entering student information

agrwbdE

From the "Main Menu" click on "Work with students".

Click on the "Work on this Record" button next to thprapriate student.
On the "Forms Menu" click on the form in which yoishkvto work.

Enter the necessary data.

Click "Save" so that your changes are saved to therse

NOTE: You can navigate through multiple-page forms by clickimg'Forward" button at the top of
the screen. Make sure to "Save" your changes beforegaitppage.

18



2.3.6 Exclusive rights

ER Forms has always had a feature that prevented o#rarfusm accessing the same page of a
particular student's report while you are working on iawiNall student forms have this feature.

When you navigate to a form you are given "exclusivitsigto that page for one hour (provided that
nobody else has already begun working on the same stuftent). As long as you continue to
"Save" the page at regular intervals within that hourr@gemmend saving every 20 minutes), your
"exclusive rights" will be retained and you can work lot fparticular page as long as you want.

Information in the navigation bar keeps Individualized Educaton Program [ oo | [ [b rorrs] [Bomoe |

you informed of the status of your t St o Goto. - e |
"exclusive rights". Five minutes before the —— = " [ |
time that your "exclusive rights" will end, — S i
a warning with a bright yellow background will

appear in the navigation bar to inform you that your 'lesiek rights" are about to expire. If you do
not "Save" the page to retain your rights, that warmiiigchange (at the time of expiration) to inform
you that your rights have expired.

If a team member/administrator is working on the satngesit and they navigate to the same form that
you are working on, they will get a popup that state<

- - -ID IoOWs lnterng Xplorer [i_hj
WARNING: [Your Name] (last login: date/time) s
appears to be already working on this page. The ARG SomeTewhr Lo g 13700013008 M) o
save button has been disabled.
After the other user clicks "OK", the form will be

available to them in read only format (no changes !
be saved) and if they do hit the "Save" button, an
additional popup warning will be displayed with the same bag&cmation.

NOTE: If you ignore basic recommendations and wait lortgan an hour to "Save" your work, all of
your changes could be lost if another user begins wotkindpe same page after your "exclusive
rights” have expired. Please pay attention to warramgisplease take note of the following examples.

Example 1

Sally opens section 5 of Johnny's ER at 2:00pm. She hassexctights” in section 5 until 3:00pm.
Sally "Saves" her work each time she completes apasph and/or completes a few lines of data
(when the page is "Saved", "exclusive rights" aretrgsene hour). Meanwhile, Kim saves a form that
she is working on and navigates to section 5 of JohnnyatBER1pm. Kim is warned that Sally is
working on that page and navigates to another form until 4inished.

Example 2

Sally opens section 5 of Johnny's ER at 2:00pm. She hassexctights” in section 5 until 3:00pm.
Sally concentrates and continues to work witHsat/ing". Meanwhile, Kim saves a form that she is
working on and navigates to section 5 of Johnny's ER at 3:08atfly's "exclusive rights" have
expired so that Kim can access the page (unawaredhatsSalso working on section 5). Kim then
has "exclusive rights" to section 5 until 4:01pm. At 3:308ally finishes her work in section 5 and
clicks the "Save" button. Since Kim now has "exslagights” to section 5, Sally will get a popup
informing her that: Kim appears to be working on this pagkthe save button has been disabled.
After clicking "OK" the information on Sally's page kévert to whatever Kim has saved or what is
currently in the database (all of her work, since 2pithbe lost). 19



2.3.7 Spell check

1. After you have navigated to a form and made changels,ocﬂid:he button in the SpEd
Forms navigation bar.

) B ) Ig Suallh Sz = W duies L2zt Eelur=) __J |h§
NOTE: The Only flelds that WIII be Checked are| Windowss ntermeisxniorer g_h:tps:p’,ispedforms.org,iiavascr\ptspeHchecKl':erverEngine‘asp
the teXt flelds Wlth a Scro”bar on the rlg ht Slde A There are no narrative Figl NS:;:;TEQE‘;:;”;‘JS studnt’s form.
If there are no fields to spell check on this page g4
warning box will popup stating that "There are t N [tsswpems]
- - n students Change
narrative fields to check". (|
& | https:f/spedforms.org/javascrif AutoCorred t
2. A new window will appear and if a word is e e
suspected of being misspelled, it will be shown Hom e
bold red text. Suggestions of the correct spellir 0 tew semence o Qs LA
.
will also be shown.
. i . [ Cancel ] [ oK
NOTE: If you are working on a Spanish page ir TR

SpEd Forms you can change the dictionary to
Spanish by choosing "Espanol" from the drop down box tee¥Dictionary language”.

3. Make sure the correct spelling is highlighted and clickherfChange" or "Change All" button.
If you want to skip making changes to that word click lgm8re Once" or "Ignore All" to skip
all words that are spelled the same.

NOTE: If none of the suggestions are spelled correctlyk cicthe misspelled word in the top
window and make the proper corrections. Click on the hig@abutton to set the correction.
This word may then be shown as misspelled again in thevitedow if it is not found in the
dictionary. If you want, you can then click on thedtito Dictionary" button to add that word
to your personal dictionary.

When the spell check is checking grammatical errors thidswwill be shown in bold green text
(or just normal text) and the "Ignore All", "Add to Diatiary”, "Change All" and

"AutoCorrect” buttons will be grayed out (unavailablef)ydu do not want to check or correct

grammatical errors, uncheck the "Check grammar" buttangsmes the spell check can be a
nuisance by bringing up too many grammar suggestions and siagle or number sequences
from table data).

When misspelled words are being found you can click ofiQ@ipgions..." button to set some of
the advanced features. Click on "Reset Personal Dayd to clear out any words you have
added to the dictionary or click on the "Reset AutoCotitectlear the "AutoCorrect” database.

4. Click "Done" to stop. A summary will then shown the number of words checked/changed.
5. Make sure to "Save" the page you are working on aftespilechecker has completed.



2.3.8 Printing forms

Please make sure to read section 1.1 of this user guide pefaneg any forms from SpEd Forms.

To print the completed form, make sure that anything yeyenting has been saved by clicking
"Save" from the SpEd Forms screen before printing.

1. Click the "Print" button at the far right of the $pEorms navigation bar.
2. DO NOT use the "Print" command from the "File" menu.

Special instructions:

PC users can use CTRL + P as a shortcut.

Macintosh users will see a "Print Preview" page betloegform prints. After clicking the
"Print" button in the SpEd Forms navigation bar (as desdrabove) use the browser's File/
Print feature (if a print dialog box does not come up auticailyy) or use COMMAND (open
apple) + P as a shortcut.

Printing the entire IEP, IFSP, llIP, ER:

Users can print all the pages of these
service plans rather than printing each
page individually.

1. Navigate to the "Forms Menu"
of the appropriate student.

2. Click on one of the service
plans listed above.

3. Click the "Print..." button
(directly under the service plan
name/student’'s name).

4. A new window will appear
with check boxes next to each
form page.

5. Select the pages you want to
print and click on the "Print
Selected Pages" button.
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3. Working with forms

3.1 Creating history pages

Many forms can be stored electronically for futurenexfee. They include:

- Prior Written Notice / Notice of District's Proposedtian or Denial
- Notice of Educational Evaluation/Reevaluation Plan

- Notice of a Team Meeting

- Agreement Regarding IEP Team Member Attendance

- All pages of the Evaluation Report

- All pages of the Individualized Education Program - (IEP)

- Progress Report (IEP)

- All pages of the Individualized Family Service Plan @S

- All pages of the Individual Interagency InterventioarP(l11P)

- Periodic Review (llIP)

3.1.1 Creating a history page for a student

1. From the "Forms Menu", navigate
to one of the pages listed above.

2. Make sure all information has
been "Saved" on the pages that are
going to be finalized.

3. At the top of each of these pages
you will notice a "Finalize" button.

NOTE: If you are creating a

history from one of the service

plans (IEP, IFSP or IIIP), you

must first "Validate" the form.

When you click the "Validate"

button, your form pages will be

checked for required fields and/or inconsistencies. I§sue is found through the validation
process, you will be given the opportunity to change thiekks before you follow through
with "Finalization". Make any changes as needed to gdtisfvalidation process.

4. Click on the "Finalize" button.

NOTE: Once the "Finalize" button is clicked, a copy is matlthat form and can be viewed by
clicking the "History" tab on the forms menu (see $&c#.3.5 for more information about viewing or
deleting a student's history). The current informatiotwarking copy" of the original form is not
changed.



3.2 Working with goal pages

The IEP, IFSP and IlIP all have goal and objective palyes! can fill these goals out with your own
goals or SpEd Forms has a bank of goals and objectivesathde used to help complete these pages.
All of the goal pages work in a similar manner so thsneple can be used to fill out any of the goal
and objective pages.

This example uses page 4 of the IEP. To get to this page:

Navigate to the "Main Menu".

Click on the "Work with Students" button.

Click on "Work on This Record" for the relevant student.
Click on "IEP" (Service Plan) from the "Forms Menu".
Click on page 4. Student Performance (goals).

agrwdE

You are now at the goal page for goal #1, as indicateteblggading on the top left of the form
("Goal/Outcome [1 ] of 3").

NOTE: As the number of goal pages
increases, this heading will change to
reflect the total number of goal pages.
The number of goal pages is also
indicated at the top right of the page.
The number of pages in the "Go to
Goal" box will increase as your goal
pages increase.

Clicking on the goal page number will
take you to that particular goal.

You can renumber the goal pages by
simply going to that goal page,
clicking in the goal number box,
changing the number, and clicking
"Save".

23
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3.2.1 Entering your own goals

1.
2.
3

6.

Follow the steps from section 3.2 (above) to geté@tial pages.
Select a category from the "Select Category" drop dmwn
Enter the "Present Level(s) of Academic and Funati®erformance" as needed.

NOTE: This area will appear on every goal page you printolf go notwant it to show on a
page, do noénter any information in the present levels area.

Enter the goal information under "Measurable Annual'Goal
Click the "New Objective" button to enter your objees. You may add as many objectives as
you like for each goal.

NOTE: You can reorder your objectives by changing the nunmbre box to the right of the
"Objective/Indicator" heading and clicking the "Savaettbn.

Enter "How will progress toward meeting this annual §eaheasured?" as needed.

NOTE: Always remember to click the
"Save" button or the text of your goals &
objectives will be lost.

3.2.2 Using the goal bank

1.

Follow the instructions in section
3.2 to access the goal pages for a
student IEP, IFSP or lIIP.

Click on the "Choose Goal" button
at the top of the page.

In the goal bank search box select
a category, then a subcategory and
choose the goal bank you want to
access from the drop down menus.

NOTE: If you choose "My Goal
Bank", you will get a listing of the
goals you have entered into your
custom goal bank. From this screen
you can also manage your custom
goal bank by using the button in the
navigation bar (also see section 1.4).

No ok

Click "Search".

Click on the "Choose Objectives" button under thesagiegoal.

Then put a check in the box next to the objectivesmant to include with this goal.
Click "Add to goal page".

NOTE: The student's name will be incorporated into the goalr@ndeach objective wherever
CHLD is used. You will be able to edit any part of thelgoae it has been selected and inserted
into the goal page.



3.2.3 Measure the progress of an objective

While working on the goal pages, the progress of each olgexan be followed in detail through preset
measures. You can keep track of the student's progressdrging the results of each encounter.

1. Follow the instructions in section
3.2 to access the goal pages for a
student IEP, IFSP, or IlIP.

2. Click on the "Measure Obijective"
link next to the objective you want
to measure the progress of.

3. Onthe "Measure" page select a
measure from the drop down box,
enter a score and the date the
objective is expected to be achieved.

NOTE: If "No measures are entered"
you can enter them in the "Measures
Bank" of "Your Setup” (see section 1.5).

4. Come back to this page as necessary
and add results by entering the date,
time and score for each achievement
and then click the "Add" button.
5. Click the "Save" button to save your changes.

NOTE: You can "remove" any of the results that haveaalyebeen added by putting a check in the box
next to that result or make any other necessary chamgkslick the "Save" button.

3.2.4 Chart the progress of a measure

When a number of "Results" have been entered for dasune (section 3.2.3) a graph can be created to

get a detailed visual representation of the
student's progress through that objective.

1. Follow the instructions in section
3.2 to access the goal pages for a
student IEP, IFSP or lIIP.

2. Click on the "Measure Obijective"
link next to the objective you want
to measure the progress of.

3. Onthe "Measure" page click on the
"Chart progress" link.

NOTE: In order to "Print" the chart or graph

you must click on the graph to activate it.
Then use the "PRINT" button at the top right of thart.

25



3.3 Services and modifications page

Information about the services provided to students caollexted by the school or district
administrator. For this information to be accurdte,gervices and modifications pages need to be filled
out in a certain way.

Add a new service

1. While you are "Working with students", in the "Formemd", click on "IEP".
2. Inthe IEP menu click on "Services and Modifications"
3. Click the button labeled "Add
Special Education Services".
4. A yellow box will appear for your
service.

Enter information about the service
provided to the student

1. Select the service you are providing
from the drop down box or in the
box labeled "Other" (if available).

Important Note: Whenever
possible, select the service from
the list of services provided. If
you type a service in the "Other"
box, the information cannot be
collected by your billing person
for the purposes of tuition billing.
If you need services added to the
services menu, contact your SpEd
Forms administrator.

2. Indicate the setting in which the
service will be provided by entering the "Location” in thaegal/special education field.
3. Enter the "Start Date" and "End Date".
4. Enter, in the "Frequency" field, the number of tinfesgervice is to be provided to the student
for each period (usually "week"). For example if the studeceives the service five times a
week type "5" and select "week".
Enter the number of direct and indirect "Minutesgession".
Indicate the "Anticipated duration” for which the stutdsill receive the service.

o o
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Indicate service provider

You should indicate the person providing
this service to this student. This
information can be collected by the
special education director and business
manager to assist with teacher workload
analysis and tuition billing.

To indicate the provider of the service,
click on the "Providérlink. Then in the
popup window, click "Select" next to the
provider's name (names will appear in
alphabetical order by last name).

Calculating service minutes

SpEd Forms helps you calculate the number of service esifiot each service to be received by the

student over the course of an IEP. Your school distiay require you to enter the information

needed to calculate service minutes.

1. Toward the bottom right of each service you will seres for the Multiplier & Total Minutes:

2. Inthe "Multiplier" box, enter the number of scha@eks this IEP is in effect. This number
will usually be 35, 36 or 37 depending on the length of yowaicyear. If the IEP is for part
of the school year enter the number of school wésk$EP is in effect.

3. Click on the "Save" button.

4. The "Total Minutes" will then be calculated and digpthfor the indirect and direct minutes of

service provided over the course of this IEP.

Important Note: SpEd Forms calculates the total minutes by multiplying:
(frequency) x (minutes per session¥ (multiplier)
If your frequency is not "weeks" you will need to adjust yourmultiplier accordingly.

27
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Fields on the services and modifications page

Service #
This number determines the placement of the servicbeoprinted services page. To re-order
services, change the numbers in these boxes.

Active
Check this box for services you wish to print. Unchexkservices you wish to keep in SpEd
Forms for the purposes of tuition billing but are no lorgat of the current IEP.

Instruction or service provided
A menu appears here with the list of services provided bydistrict. Use this menu to select the
service being provided to the student.

Provider
Select the name of the person providing the service themprovider menu. This information is
used to analyze teacher workloads.

Location
Enter "X" in either the General Education or Spec@&ation box to indicate where the service is
being provided. You may also type the actual locatioh@ervice (eg: room number).

Start date
Enter the date on which this service commences.

End date
Enter the date on which this service ends. This datarddg®int but is collected on your school
services report.

Frequency
Enter a number in the left field and select an opfiom the menu to the right. The anticipated

frequency records the number of times the servicebeifprovided per time period. In most cases
the period will be "week".

Minutes per session
Enter the number of Indirect and Direct service misyg®vided to this student.

Anticipated duration
Enter a number in the left field and select an opfiom the menu to the right.

Multiplier
This number is used to calculate the total number of mirngies provided to the student. This

number is multiplied by the frequency and number of ministesiculate totals.

The following examples are assuming a frequency of "(x) weeks".

#1. A service is provided for an entire school year (36kseePut 36 in the "Multiplier" box.

#2. This service is provided for only part of the schookyéeehe number of weeks being provided
is 12. Enter 12 in the "Multiplier" box.



3.4 The progress report

When you first open the IEP progress report, the "Garad''Comments" sections will be
automatically populated with the student's current annualistginal goals and objectives.

3.4.1 Adding additional comments to existing goals

1. Type in additional comments or
make any changes as needed.

2. Click "Save" so that your change
are saved to the server.

\°ZJ

NOTE: Saving changes to goals in the
progress report will not effect goals on the
student's goal page.

3.4.2 Clear/Refresh progress report
(case managers only)

NOTE: This button only appears for the
student's case manager or administrators.

[72)

If changes have been made on the
student's goal page or goals have been
cleared out in preparation for the coming
semester and you would like those
changes to appear in the progress report.

1. Click on the "Clear/Refresh
Progress Report" button.
2. Click "Save" so that these changes are saved &ether.

CAUTION: Clicking on the "Clear/Refresh Progress Repot" button will erase any additional
comments or changes you have made to the progress report andlwiport the current goals
and objectives that have been most recently saved on the stitls goal page.



3.5 Reports

Teachers and administrators rely on reports to give tleenplete and reliable information. Without
knowing how these reports work, it may be difficult t@knwhat information is needed for these
reports to work properly.

NOTE:

An important thing to remember

is that several of the reports for teachers
and administrators alike use specific data
from other SpEd Forms pages to
determine what students show up on the

report.

3.5.1 Combined report

PwnpE

NOTE:

Navigate to the "Main Menu".
Click on the "Reports" button.
Click on the "Combined report".
Choose the IEP manager or
service provider option & pick the
"Order By" criteria (if necessary).

If you choose "IEP Manager", all

the students that you are IEP manager for will be shmwithis report. If you are the service provider
you may not have any students that are assigned to yolhbuatyeu choose "Service Provider", the
accompanying report will reveal any students where you arprtvider for at least one service. The
service provider's ID is indicated in the "Provider"” fididttis located on each service and available on
any service page (see the explanation of "Indicate sepvavider" in section 3.3 for more

information).

3.5.2 Teacher workload analysis

1.
2.
3

4.

NOTE:

Navigate to the "Main Menu".
Click on the "Reports" button.
Click on the "Teacher workload
analysis".

Fill in the number of evaluations
and re-evaluations (if necessary)
and click on the "Save" button.

The "Teacher Workload Analysis" report is directhatetl to the service provider's ID in the

"Provider" field that is located on each service andlavia on any service page (see the explanation
of "Indicate service provider" in section 3.3 for mor@mfation).
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5. Getting started in ER Forms

PLEASE NOTE If ER Forms is installed for your districtwith ER Forms! will be shown in red next
to the evaluation report on the forms menu. Beforesyan using ER Forms you must ensure your
computer is setup correctly. Please see "Configuring YourgDter" (section 1.1 of this guide) if you
have not already done so.

Overview of editing modes

There are two completely different editing
modes that can be used when editing text
in the various sections of ER Forms. The
original way of using simple text editing
commands has been the standard for
several years. This involves the use of
carriage returns (using the "enter" key)
and spaces along with a fixed-width font
(Courier) to line-up text and tables much
like you would while using a simple text
editor like Notepad, SimpleText or
TextEdit. A new editing feature has been
added to ER Forms where buttons can be
clicked to modify the text including bold,
italic, underline, alignment, indentation
and the insertion of tables. This robust
editing feature has been made available
through specific web browsers by a
technology called DesignMode. In most
cases DesignMode has been made the
default mode of editing in ER Forms.

If your SpEd Forms administrator has allowed the us& ext'Mode", you will see an option in "Your
Setup (Profile)" that you can use to choose whetheigbBElode is on or off by default (see section 1.3
for more information). You will also have an opportynit choose either editing mode when you
begin a new evaluation report (when choosing a newlgeyheck/uncheck the "DesignMode™
checkbox before choosing the local/SpEd Forms template

Important Note: Once you start an evaluation report, you must complete itsing the same mode.

DesignMode requirements

To use the DesignMode editing features, you must haeastt Internet Explorer 6, Opera 9 or Firefox.
Please make sure you are using a compatible and updated browser (sterd/dadows versions of Firefox/
Mozilla/Netscape had been reported to drop the spaces between wordsawifteyin DesignMode).
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5.1 Choosing your first template

1. Navigate to the "Forms Menu" for the student you wasivdrk on.

2. Click on the "Evaluation Report" link toward the togled "Forms Menu".

3. A message will appear asking if you would like to seléetglate for your evaluation report.
There are two types of templates (besides a "blagdrteavailable for you to choose from.

. Local District TemplatesThese are templates created by your school districboperative,
for your use.

- SpEd Forms Template&eneric templates for each of the major disabditsas used
statewide.

NOTE: If this student already has
a template, you can choose a new
template by clicking the "Choose a
New Evaluation Template" button
on the bottom of the menu page.
If you follow through with
choosing a new template, your
existing template will be
overwritten. See section 7 for
additional instructions on how to
"Select a Template".

4. To start with a "Text Mode" template make sure "Balgiode"” is NOT checked (if available).

NOTE: DesignMode templates are specially formatted to waitk the features of
DesignMode. If you choose not to use DesignMode tenglgter must use the original basic
rules to edit the sections of your evaluation report.

5. If you choose "Blank Evaluation
Report” you will be taken directly
to the evaluation report menu. If
you chose "Local District
Template" or "SpEd Forms
Template", a list of templates will
appear. Click on the "Preview"
button next to the template you
wish to view.

6. A preview of the template you
selected will be shown. If this is
the template you want to use for
your evaluation report click
"Select This Template", otherwise
click "Select Another Template" to
view another.

7. The template will be automatically entered intodteluation report and you will be taken to
the evaluation report menu.



6. The evaluation report menu

The evaluation report is separated into twelve areagle8t information, sections 1 to 10 and the
signature page.

6.1 Determining if DesignMode or Text Mode is being used fdhis report

1. You can determine if DesignMode is ON or OFF by lookingh@ "DesignMode" button. The
button will show a green (ON) box if DesignMode ishaeiand a red (OFF) box if
DesignMode is inactive.

Important Note: Once you start an evaluation report, you must complete itsing the same mode.

6.2 Navigating to different sections of the evaluation report

1. To navigate, simply click on the name of the areawsih to work on.

- Student informationReplicates the first page of the state recommendaidation report.
NOTE: If you entered an evaluation report prior to inst@lIER Forms, you can view it on
this page.

- Sections 1 to 10This is where
you write the bulk of your
evaluation report. Each
section expands up to
1,000,000 characters or about
100 typed pages (Internet
Explorer on the Mac is limited
to 32,000 characters or 4-5
typed pages for each section).
When the entire evaluation
report is printed, all sections
(including the student
information page, sections 1
through 10 and the signature
page) can be printed together
as one report (see section 13
for more information about
printing the entire evaluation report).

- Signatures pagdReplicates the last page of the state recommendedagieal report.
Attach this page to your evaluation report.

NOTE: If this student already has a template you can chaeossv template by clicking the
"Choose a New Evaluation Template" button on theobotf the menu pagdf you follow
through with choosing a new template, your existing templateill be overwritten. See
section 7 for additional instructions on how to "Seletemplate".
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7. Select a template

SpEd Forms contains templates for each major disabig. Your school district may also create
custom templates for your use.

7.1 Selecting a new template

1. Navigate to the ER Forms menu.

2. Click on the "Choose a New
Evaluation Template" button at the
bottom of the ER Forms menu.

3. At the next screen choose the type
of template by clicking on the
"Local District Template", "SpEd
Forms Template", "Blank ER
Template" or "Cancel" to go back
to the ER Forms menu. Uncheck
DesignMode (if available) to
choose the original "Text Mode".

WARNING : If you "Choose a New Template" the student's existing evahtion report will
be overwritten.

4. If you "Choose a New Template"
you will be redirected to the
template server and a list of
templates will appear. Click on
the "Preview" button next to the
template you wish to select.

5. A preview of the template you
selected will be shown (the
template will be formatted in
DesignMode unless your
administrator has allowed you to
unchecked DesignMode). If this
is the template you want to use for
your evaluation report click
"Select This Template", otherwise
click "Select Another Template" to
choose another.

6. The template will be automatically
entered into the evaluation report
and you will be taken to the
evaluation report menu.



8. The student information page

The student information page replicates the first pagtaté recommended evaluation report.
Demographic information is automatically transferred lifas been entered elsewhere in SpEd Forms.

8.1 Editing the student information page

1. To open the "Student
Information" page navigate
to the ER Forms menu.

2. Click on the "Student
Information” link. The
student information page will
appear.

NOTE: If you had entered an

evaluation report before ER

Forms was installed on your

server there will be a button

available at the bottom of this

page that you can click on to

show your prior report. The

text that is displayed here is

provided for your convenience and

if it is your current evaluation

report, you should copy and paste

this information into any of the

other sections (1-10) of the

evaluation report. You must click

on the "Show pre-ER Forms

Evaluation Report" button each

time you navigate to this page to

display the text (if this is from an old evaluatiopoe, please disregard this feature, it will not
be printed when you print the evaluation report).

3. Edit the demographic information where necessary.
4. Click the "Save" button to save the changes on ypEd3orms server.

Remember to SAVE often.
We recommend that you
SAVE every 20 minutes.

Please see section 2.3.6 for more details
concerning saving & exclusive rights.
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9. Sections 1 to 10

The evaluation report is broken into ten sections to y@lporganize your report and to provide as
much space as possible. Each section will hold upwarti8®printed pages of typed information
(using Internet Explorer on the Mac will limit spacedt-5 typed pages for each section). When the
entire evaluation report is printed, all sections (inclgdhre student information page, sections 1
through 10 and the signature page) can be printed togetbre asport (see section 13 for more
information about printing the entire evaluation repoit)you used a template for your evaluation
report, your evaluation report will be automatically orgashizgo sections.

9.1 Editing a section using the original Text Mod€DesignMode users see section 9.2)

1. Onthe ER Forms menu there

is a link to each of the ten

sections. Click on the section

that you wish to work on.
2. You may, if you wish, replace

the existing title of that page

with your own. When your

evaluation report is printed,

the title will appear above this

section in bold type.
3. Type information for this

section in the large text box

towards the bottom of the

screen. You will be able to

type over 1,000,000

characters (using Internet

Explorer on the Mac will limit

space to 32,000 characters) into

each of the large text boxes in

each section. When printed, the

box will expand automatically to show all you have typed.

NOTE: Be aware of text formatting issues (section 14 ofdghige).
4. Click on the "Save" button to save the changes on§pld Forms server.
5. The "Back" and "Forward" buttons allow you to navigatehe next and previous sections.

Remember to SAVE often.
We recommend that you
SAVE every 20 minutes.

Please see section 2.3.6 for more details
concerning saving & exclusive rights.




9.2 Editing a section using DesignModésee section 9.1 if you're using the original Text Mode)
Section 5 has more information about DesignMode (inolydn overview & system requirements).

1. Onthe ER Forms menu there
is a link to each of the ten
sections. Click on the section
that you wish to work on.
2. Changing the "Menu Title"
will only change the title that
appears on the menu page.
The title of this section is
included in the large text box
so that you can edit the text
with the DesignMode
features.
3. Type information for this
section in the large text box
towards the bottom of the
screen. You will be able to
type over 1,000,000 characters
(using Internet Explorer on the Mac
will limit space to 32,000
characters) into each of the large
text boxes in each section. When
printed, the box will expand
automatically to show all you have typed. NOBe aware of
text formatting issues (section 14 of this guide). Usddhowing instructions for enhancing
text in the DesignMode window of your ER Forms documen

Font Style -highlight any word or combination of words then select@tfStyle” from the list.
Font Size -highlight any word or combination of words then seledtant Size" from the list.
Italic - highlight any word or combination of words then click tHallc" button.

Italic - highlight any word or combination of words then click tHallc" button.

Underline - highlight any word or combination of words then click thaderline" button.
Align-Left - with your cursor in a paragraph or table, click to atigyt to the "left".
Align-Center - with your cursor in a paragraph or table, click to ceatign text to the "center".
Align-Right - with your cursor in a paragraph or table, click to ategxt to the "right".

Indent - with your cursor in a paragraph or table, click to insesthe "indent".

Outdent - with your cursor in a paragraph or table, click to de@¢as "indent".

Undo - use this button to "undo” your previous change.

Redo -use this button to "redo" changes that you have undone using the huithyi.

Table - click on the "table" button to insert a table in your docotmé\fter clicking the table
button a new window will popup allowing you to set conditions fortéiide (including its size
and appearance). NOTE: You can use a border thickne8%tof rhake the table invisible.
Single Line Spacing(windows users only)using the "enter" key by itself will put a large space
between paragraphs. Hold down the "shift" key while youdmtér" for single line spacing.

4. Click on the "Save" button to save the changes on§pld Forms server.
5. The "Back" and "Forward" buttons allow you to navigatthe next and previous sections.
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10. Copy a test

ER Forms includes a data bank of more than 100 commonlyedsedtional tests that can be copied
into your evaluation report. Your school district onvgese cooperative can also add tests.

10.1 Select a test from the test templates

To copy a test, first navigate to the section in which wash the test to appear.

1. You may copy tests from the SpEd
Forms test bank or the local
district test bank. Click on the
"Tests" button.

2. You will be redirected to the
template server. Select the
category of test you are interested
in from the menu and then click on
the "View Tests" button.

3. Alist of available tests in that
category will appear. Click on the
"Preview" button next to the test
you wish to copy to your
evaluation report.

NOTE: If your template is in
DesignMode, only tests that are
formatted for DesignMode will be
shown and if you are using the
original Text Mode, tests will be
shown that are formatted in this
mode.

4. You will be shown a preview of
the test that you selected. Click on
"Select Another Test" if you want
to preview another test or click on
the "Select This Test" button to
add this test to your evaluation
report. A message will appear alerting you that thehestbeen copied to your page.

NOTE: If you are using DesignMode, your test will be insert¢d the section of your report
at the point where you cursor was located. In themaldiext Mode the test is automatically
copied to the end of the page that you are working on (itigoniot see the test, scroll down to
the bottom of the text field in the lower half of yascreen).



11. Copy criteria

ER Forms includes a data bank of criteria for each digab¥our school district or service
cooperative can also add criteria.

11.1 Select criteria from the criteria templates

To copy criteria, first navigate to the section in whyolu wish the criteria to appear.

1. You may copy criteria from the
SpEd Forms criteria bank or the
local district criteria bank. Click
on the "Criteria" button.

2. You will be redirected to the
template server. A list of available
criteria will appear. Click on the
"Preview" button next to the
criteria you wish to copy to your
evaluation report.

NOTE: If your template is in
DesignMode, only criteria that is
formatted for DesignMode will be
shown and if you are using the
original Text Mode, criteria will
be shown that is formatted in this
mode.

3. You will be shown a preview of
the criteria that you selected.
Click on "Select Another Criteria"
if you want to preview other
criteria or click on the "Select This
Criteria" button to add this criteria
to your evaluation report. A
message will appear alerting you that the criteria has bepied to your page.

NOTE: If you are using DesignMode, your criteria will be ied into the section of your
report at the point where you cursor was located. lotiggnal Text Mode the criteria is
automatically copied to the end of the page that yowarking on (if you do not see the test,
scroll down to the bottom of the text field in the Evhalf of your screen).
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12. The signatures page

The signatures page replicates the last

page of the state recommended evaluatijon

report. If you entered information into the

old evaluation report in SpEd Forms
Internet Edition, it will automatically be
transferred here.

12.1 Editing the signatures page

1. To open the signatures page,
navigate to the ER Forms menu.
Click on the "Signature Page
(Print and Attach)" link.

2. The signatures page will appear.
Edit the information where
necessary.

3. Click the "Save" button to save
your changes on the SpEd Forms
server.

4. Attach this page to your evaluatign

report.

NOTE: When the entire evaluation repof
is printed you will have an opportunity tg

—+

include the signature page (see section [L3

for more information about printing the
entire evaluation report).




13. Printing the evaluation report

13.1 Printing the whole report

1.

Navigate to the ER Forms
menu. Click on the "Print
Preview" button.

A new window will appear
with check boxes next to each
page.

Select the pages you want to
print and click on the "Print
Selected Pages" button.

13.2 My ER prints off the page!

1.

wn

If your ER goes off the side of
the page when you print or it
is very wide when viewed in the
"Print Preview" window, you may
have extraneous characters or spaces
in your document.

Select "Edit" and click on "Select All". This willghlight all of the text in your document.
Scroll down until you find a

highlighted area that goes all

the way across the page, then

take note of what section it is

in and close the "Print

Preview" window (you cannot

make edit changes in the "Print

Preview" window).

Open the appropriate section,
replace whole lines with
carriage returns and make any
other pertinent corrections.

Hint: You can click
anywhere in the text box and
use the "Select All" feature
to highlight all of the text.

"Save" this section and open
"Print Preview" again as
described in section 13.1
(Repeat these steps if you
need to make additional
corrections).
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14. Text formatting issues

Keep in mind that while you type and layout text in the bexes provided to make your evaluation
report, even with the robust features of "DesignMod®s, is by no means a full fledged "Word
Processor". There are also specific text formaitsages that come into play when you cut/copy and
paste text from another "Word Processor".

14.1 Lining up text or information in a table

1. While using the original Text Mode editing features ofEERRMS, please use the spacebar to
line up text or information in a table. DesignMode usarsinsert tables to organize blocks of
text. The "Tab" key is used (by the web browser) toertmetween text fields and you will not
be able to type a "Tab" into any text field on a web berws

14.2 "Cut/Copy & Pasting" text from another program into the DesignMode window

1. If you "Cut/Copy & Paste" text from another progrdnatthas "Tabs" formatted into the text,
they will be converted to spaces in the DesignMode windimnight be more desirable to
create a table in ER Forms and copy the elementsstteatibie.

14.3 "Cut/Copy & Pasting" text from another program into the original Text Mode window

1. If you "Cut/Copy & Paste" text
from another program that has
"Tabs" formatted into the text,
they will show up on the screen
but will not print. You can tell if
there are "Tabs" in your text by
placing your cursor in a line of
text and using the arrow keys on
your keyboard to move back and
forth. If the cursor jumps a long
distance with one move of the
arrow key, you may have "Tab"
characters in your document.
Delete any "Tabs" and use the
spacebar to line up the columns.

NOTE: If your document looks fine on screen but the columasat lined up when you print,
there are probably "Tab" characters in your document.

2. Fonts are converted t€6urier " (a fixed-width font) when pasted into the SpEd Forms
evaluation report. This is intentional, so that ewehgracter remains the same width (ah "
will take up the same space as at)."

3. Occasionally your web browser may not translateiapeharacters correctly when "Pasted"”
from specific operating systems or specific programsargquotes{(”) or (‘') may cause
unexpected behavior in some situations. Try changing tbestnaight quotes’() or (').



15. Getting started in MA Forms

PLEASE NOTE Before you start using MA Forms you must ensure yompaiter is setup correctly.
Please see "Configuring your computer” (section 1.1 of thaegif you have not already done so.

15.1 Accessing the MA Forms menu

As soon as MA Forms is installed on your
SpEd Forms server, it can be accessed by
clicking on the "MA Forms" tab toward

the top of the "Forms Menu".

1. Navigate to the "Forms Menu" for
the student you wish to work on.

2. Inthe row of yellow tabs toward
the top of the "Forms Menu" click
on "MA Forms".

3. The MA Forms menu will then
appear.

15.2 Student billing setup

1. Navigate to the MA Forms menu.

2. Click on "MA Billing Setup".

3. Fillin as much of the billing
information as you can for this
student.

NOTE: Fields shown in red are
important for third party billing.
You can continue to use MA
Forms if some of this information
is missing but the MA billing
administrator cannot bill for
services until all of the required
information has been completed.

4. Click on the "Save" button to save
your changes and navigate back to
the MA Forms menu by clicking
on the "Form Menu" button.



16. Entering MA billing information

16.1 Working with activity logs

1. Navigate to the MA Forms menu.
2. Click on the "Activity Logs" link.

NOTE: The activity log menu shows no
more than 12 logs by default. You can
change this number and then hit "Enter"
but it will default back to 12 when you
quit and login to SpEd Forms again.

16.1.1 Create a new activity log

Navigate to the MA Forms menu.

Click on "Activity Logs".

On the activity log menu, click on

the "New Activity Log" button.

4. You are then taken to a new IEP/

IFSP services activity log sheet.

Select the "Type of Service provided" and then clickher'Add Activity" button.

Change the "Date of Service" to the actual date tiviceeras provided, fill in the time spent,
the number of children that were in the group and ty@edascription or choose one from the
descriptions drop down list. When the "Mark as Not BI#4 box is checked that service will
not show up on the MA Billing Administrator's list oe{mbursable) services.

wnN P

o o

NOTE: You can duplicate any number of activity lines by typim@ inumber in the "Duplicate
for (number of days)" box and clicking on the "Duplicabetton (if this box is left blank only
one log will be duplicated). You can delete activity liretsany time before they are billed, by
clicking on the "Delete" button next to the log you wemtlelete.

8. Fillin your name and title or the name and titlehaf person fulfilling this service.
9. Click on "Save" when you are finished and this log s¥itbw up on the activity logs menu.

NOTE: Use the "Finalize" button at the top of the pageender the log as finalized or completed.
Some districts take this into account when they aildibg a batch of (only) "Completed" claims. If
you need to make changes to the finalized log click on teactate log" button to reactivate it.

16.1.2 View/Delete existing activity logs

1. Navigate to the "Activity Logs" menu (section 16.1).
2. Click on "View" next to the log you want to view.
3. Click on "Delete" next to the log you want to delete.

16.1.3 Duplicate existing activity logs

1. Navigate to the "Activity Logs" menu (section 16.1).
44 2. Click on "Duplicate" button next to the log you wanttglicate.
3. Aduplicate log will appear with today's date as the "Datg". Make changes as needed.



16.2 Working with trip logs

1. Navigate to the MA Forms menu.
2. Click on the "Trip Logs" link.

NOTE: The trip log menu shows no more than 12 logs by defddu can change this number and
then hit "Enter” but it will default back to 12 when youtcnd login to SpEd Forms again.

16.2.1 Create a new trip log

1. Navigate to the MA Forms menu.
2. Click on "Trip Logs".
3. On the trip log menu, click on the
"New Trip Log" button.
4. You are then taken to a new IEP/
IFSP services trip log sheet.
Click the "Add Trip" button.
Change the "Date of Service" to
the actual date the service was
provided and in the "Miles from
pick-up to drop-off " for each trip.

o o

NOTE: You can duplicate any

number of trip lines by typing in a

number in the "Duplicate for

(number of days)" box and

clicking on the "Duplicate" button

(if this box is left blank only

one log will be duplicated). To duplicate one log, click the

"+" button next to the log you want to duplicate or you dalete any of the trip lines, at any
time before they are billed, by clicking the "-" buttonxti® the log you want to delete.

7. Fill in your name or the name of the person respanilcompleting this service.
8. Click on "Save" when you are finished and this log s¥itbw up on the trip logs menu.

16.2.2 View/Delete existing trip logs

1. Navigate to the "Trip Logs" menu (section 16.2).
2. Click on "View" next to the log you want to view.
3. Click on "Delete" next to the log you want to delete.
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16.3 Entering form information

46

1. Navigate to the MA Forms menu.
2. Click on the form in which you
wish to work.

Enter the necessary data.

Click "Save" so that your changes
are saved to the server.

Hw

NOTE: If a form has multiple pages,
you can navigate through the pages by
clicking the "Forward" and "Back"
buttons in the SpEd Forms navigation
bar. Make sure to hit "Save" before
exiting a page.



17. Frequently Asked Questions

17.1 General questions

1.

Am | automatically disconnected from SpEd Forms after a ceain period of time?

SpEd Forms will persist your connection for up to 24 hottswever, we recommend that you
save your work at least every 20 minutes, especially wioeking on a dial-up internet
connection.

A message appears saying that the "Page cannot be displaye@hat's wrong?
This is a general message displayed by Internet Expiren your computer cannot connect to the
server.
1. Check your internet connection. If your internetr@mtion has been disconnected, this
message will be displayed.
2. Check to make sure you have correctly followed the Setuyedtwes outlined on Section 1.1
of the User Guide (This message may be an indication that your page caching setting is itgorrec
3. If you continue to get this message please contactSpitid Forms Administrator.

How do | make a backup of my student information?
Your student information is stored on your school dissrlSpEd Forms server. Your SpEd Forms
server administrator should make a daily backup of the datdstoryour SpEd Forms server.

I'm using Mac OS X, what browser works best with thdeatures of SpEd Forms? (Mac Only)
We recommend using Firefox2. If you are using Opera, iksvbine. For a comparison of how
some of the more common Mac web browsers work welfeatures of SpEd Forms, refer to our
Mac Test Results page dittp://www.spedforms.com/support/mac_test_results.htm

Two students appear to have their information mixed up. Bw did this happen?
SpEd Forms remembers which student you are working on. éifavior described can occur for
two reasons:

1. If somebody else logs into SpEd Forms using your user aathpassword, then SpEd Forms
may confuse the student you are working on with the stublerdgther person is working on.
Never share you user name and password.

2. If you work on two computers and do not "Quit" SpEd Formsrbefmving to the second
computer, SpEd Forms may confuse the students you aking@n. Always "Quit" SpEd
Forms before moving to a new machine.
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6. Erroneous information is automatically entered into my forms How do | turn off "Autofill"?
When "Autofill" is turned on, the computer tries to auttioaly fill out forms. This can cause

strange things to happen.
PC Userginternet Explorer)
1. Select "Internet Options" from the "Tools" menu.
2. Click the "Content" tab then click on the "Autoconme'doutton.
3. Uncheck "Forms" and "User names and passwords on"forms
4. In the "General" tab, click on "Delete..." (browsing twg) and "Delete forms/passwords".

Mac UsergqFirefox2)
1. Select "Preferences..." from the "Firefox" menu.
2. Choose the "Privacy" tab and uncheck "Remember wimael @ forms and the...".
3. Choose the "Security”" tab and uncheck "Remember passfoosies".
4. Click on "Show Passwords..." then click on the "Resnall" button.
Mac UsergOpera)
1. Select "Preferences..." from the "Opera" menu.
2. Choose the "Wand" tab and uncheck "Let the Wand remgrabswords".
3. Clear out any (auto-complete) data then click on \iRarsls" and delete all wand logins.

7. When I'm using ER Forms a message appears stating: "This pagentains both secure and
nonsecure items. Do you want to display the nonsecure iteff (PC Only)
This message may appear if you have not completed theeteyw instructions for DesignMode.
The following instructions will also appear in sectioh.1.of the SpEd Forms user guide.
1. Open Internet Explorer and select "Internet Optidresth the "Tools" menu.
2. Select the "Security" tab and click on the "Custowele" button.
3. In the "Miscellaneous" section - enable "Displayx&di Content” (When you click "OK"
you will be asked if you want to change the securityrggstiThis is to prevent the warning
box from being displayed in "Design Mode", it has nothimglo with the security of your

computer).

8. A "debugging" window keeps coming up. Is this an errowith SpEd Forms? (PC Only)
You can Disable Script Debugging in Internet Explorer's septions.
1. Select "Internet Options" from the "Tools" menu ahdose the "Advanced" tab.
2. In the "Browsing" section put a check in both "Disahteipt Debugging” boxes.



17.2 Working with student information

9. | cannot add a new student, | get a message saying thed&nt already exists!

The Student ID number is used extensively throughout SpEds-oA student cannot be added if
the Student ID you are using for the new student alresdise There are several reasons why a
student may already exist in the system.

1. This student may already have been added by another |1BRybta

2. This student is inactive. Activate the student.

3. Students that had been deleted by an IEP Manager pfit/@® will still be in the system

and need to be reassigned by the Administrator.

NOTE: Contact your SpEd Forms administrator, theysesmch for the Student ID number you are
using and determine if the student already exists in therays

10. A student does not show up in my list. I'm sure they arassigned to me. Where are they?

Solution 1: The student may not be assigned to the same scistradtcs the teacher.
To show the student: Click on the "Work with studentgtdn. In the drop down box above the
list of students select "Students served by all districts
NOTE: To facilitate better organization of studentsté&achers working in multiple districts,
students are now organized by school district in thenerastudent list.

Solution 2: The student evaluation status is not a current speghigtiation evaluation status.
To show the student: Click on the "Work with studentgtdn. A list of active students will
appear. Put a check in the "Show inactive/exited studehexkbox.
NOTE: If the student does not show up automatically éntéfacher list, the student does not have
a current MARSS Evaluation Status. The teacher dhmrrect this issue by changing the
evaluation status for the student to a current evaluatans. SpEd Forms now keeps a history
of all evaluation status changes for future reference.

11. Can | change a Student ID on my own, or should | call mypg&Ed Forms administrator?
If you are the Case Manager for this student or havedggen Edit Access you can change the
student number. If you navigate to the "Work with studdrstsyou can edit their number if the
button states "Work on this Record" but not if it stédkésw this Record". To change the number:
1. From the "Work with students" list click on "Work tins Record" for the intended student.
2. On the "Forms Menu" click on the "Edit Setup" button.
3. Next to the Student/MARSS ID click the "Edit" link.
4. Change the number, as needed, and click "Save".
NOTE: If you would prefer, you can contact your SpEd Fordmsiaistrator and they can do it for
you as well.

12. How do | change the IEP manager for a student?
The current IEP Manager is able to reassign the sttodenhew IEP Manager.

1. Navigate to the student's "Forms Menu", click on "StuBéaring" and then the "Send this
student to a new case manager" button.

2. Select the new IEP Manager from the drop dowraifist click "Send" (put a check in the
"Reset current student sharing" checkbox if you nodomged access to this student, if you
leave it unchecked you will continue to have edit accefsgstudent).

NOTE: If you are sending this student to a remote mar(@agéon the same server), fill in the

information on the bottom of this page, click on theé&@e Fax" button and fax it to the new IEP

Manager.
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13. When | enter information in a form, then come back laterit is gone. What happened?
The changes you have made to one of your forms could bietasty of the following reasons:

1. You may not have clicked the "Save" button after yalifimshed entering information. After
you have finished making chang®sANY page, you must click the "Save" button to save
your changes to the SpEd Forms server.

2. If somebody else logs into SpEd Forms using your user aathpassword, then SpEd Forms
may confuse the student you are working on with the stuberdther person is working on.
Never share you user name and password.

3. If you work on two computers and do not "Quit" SpEd Formsrbefmving to the second
computer, SpEd Forms may confuse the students you akingg@n. Always quit SpEd
Forms with the "Quit" button on the navigation bardbefmoving to a new machine.

14. Why does the Spell Check find numbers and then only &tne ignore them one by one?
If the Spell Check only allows you to "Ignore Once" andlererrors are shown in bold green text
the Spell Check is checking for grammar. You can unchexkG@heck grammar" checkbox.

15. Sometimes | enter a date and it does not save. Why not?
If you do not enter a valid date your date will not be davEhe date format is MM/DD/YYYY. If
you enter any non-numeric characters in a date figtdat will not be saved.

16. Why are some names on my caseload not showing up on the Combifegort?
It may be because not all the proper fields are comegbleln order for a record to appear on this
report, you must have both a team meeting date and a prihsatyility entered into the system.

17. How do | exit a student from my caseload?
Only those with edit access to the student can exih fhem special education. To exit a student:
1. From the "Work with students" list click on "Work tins Record" for the intended student.
2. On the "Forms Menu" click on the "Edit Setup" button.
3. Next to "Evaluation Status", select code 2, 5 or 7 arfdfdhe "Status End (Exit Reason)”,
select a code prefaced by the word "EXIT".
4. Enter any other pertinent information and click "Save".
NOTE: Once a student is exited they will no longer siedl on the teacher's list. Contact the SpEd
Forms administrator to reassign a student that hars &eted.

18. Can the IEP be "archived" so that you can keep last year'€slP and make a new one too?
Teachers can click on the "Validate" button on the nk&hu, make any necessary changes and then
click on the "Finalize" button. A History will then Imeade of all IEP pages. From the Forms
Menu, click on the "History" tab to view any history pagest have been made for that student.

19. How do | change the goals from last year to make them currefor this year?
Simply delete the old goals and then enter the newnrton for this year.

20. How do | re-number Goals?
On each goal page you are able to type a new number @oeNumber box. After you change
the number click "Save" and the goals will be reordered.



21. Some tips for entering information into ER Forms:
The default print margins for SpEd Forms are 0.5 indhis i because most of the state due
process forms do not fit on a page with large marginsu ¢dan change the print margins by
selecting Page Setup from the File Menu. If yolckange the print margins for the Evaluation
Report, don't forget to change them back when you pnitER.

If you paste text in from another document or Word Bseimg program make sure all of the
special formatting has been omitted. Most of thesed\iRsocessing programs can save the
document in "plain text" format or you can use a sinppdggram like Notepad (PC) or TextEdit
(Mac, under "Format" select "Make Plain Text"). Use tips listed below to add formatting back
into the document.

DesignMode
1. Type up whole paragraphs of text and then go back and higtilegareas you want to

enhance (bold, italic, underline), otherwise it can becdiffieult to stop or undo these
specific enhancements as you type. The alignment ontifdétons effect the whole
paragraph where the cursor is located (not limited to theigigatl text).

2. When adding tables from scratch, put some thought imtonteny rows and columns you
will need (you cannot alter the table after it has beated). In most browsers you can
click on the outer perimeter of the table and thenheitdelete button to delete it.

3. Tests and/or Criteria are imported at the point e/biee cursor is located (not at the bottom
of the page as in Text Mode).

Original Text Mode
1. Use spaces rather than tabs to create columns withieport. Tabs are used to navigate
between fields and cannot be typed into a report. We hised a special fixed-width font
to make spaces hold so teachers can print in coluthgeu are not sure how to create
columns using spaces take a look at one of the test timsaieailable in SpEd Forms.
These test templates include columns and tables creabgdspsaces rather than tabs.
When working with spaces:
- Use the Enter or Return key to move to another line. Dos®the space bar to
advance to the next line because the browser will theagroup of spaces as one
character and force the right margin off the page wieenprint.

- Before you add more spaces to a line, make sure theretagristing spaces on this
line. You can check this by using the arrow key to movat 0g by clicking to the
right of the existing text (if the cursor jumps to whgou click, spaces exist there).

- If you choose a SpEd Forms template, click the mousdlie predefined spaces to
enter measures.

51



17.3 Printing from SpEd Forms
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22. Can | print more than one page at a time?
Using SpEd Forms, you may print the entire IEP, IFSP,dhd ER by clicking on the "Print..."
button toward the top of each of these menus (someQ®aX browsers do not support this this
feature). Additional Forms can be printed one pageiate t

23. | clicked the "Print" button, but nothing happens. What did | do wrong?
Only one print window will open at a time. It's likefgur print window is already open in the
background and the new print preview has loaded into itoufaye on a PC, click ALT-TAB to
cycle through the open browser windows until you findfityou are on a Mac, select the print
window from the "Window" menu.

24. (Mac OS Only) When | print, only the navigation buttons prirt. Where's my form?
Make sure you click on the SpEd Forms print button (ifSpEd Forms navigation bar) and then
print from the print preview window. If you select File2rnt without going to the print preview
screen, only the heading will print.

25. When | print, the web page address and other informatioprints. How do | prevent that
from printing?
Your browser should be setup to not print headers or foota'll find this setting in your page
setup or print setup window. Please refer to the "Rgriietup” found on Section 1.1 of the User
Guide

26. | seem to be only able to print the first goal/transition age. | am able to print the other goal
pages when | first create them but not when I go back.
The problem you are experiencing is probably related toatigecsetup of your browser. Please
refer to the Setup procedures found on Section 1.1 of the®&lsde

27. Can the print size be made larger?
Yes. To make the printed font larger navigate to "Youueand click on "Profile”. Select the
desired size from the "Print Font Size" drop down bGck "Save" to save your changes.



18. Where do | go for support?

Step 1: Consult the SpEd Forms user guide

Before requesting support please review the SpEd Forms Wse.B1ost support questions are from
users who have not completed the computer configur@ider to Section 1.1 of the User Guide).
Answers to most other questions asked by teachers can berdtnedjuently Asked Questions (refer to
Section 17 of the User Guide).

Step 2: Contact your SpEd Forms administrator

Your SpEd Forms Administrator is the person respon$ibladministering SpEd Forms for your school
district. This person will be able to answer most gqaastabout the program. Your desighated SpEd
Forms Administrator qualifies for technical support fr6pEd Forms.

Note: Be sure to give your SpEd Forms Administratorrca concise information. The better
information you provide, the more likely your problem w#l §olved in a timely manner.

Step 3: Contact a coordinator or special education director
If the SpEd Forms Administrator is unavailable, pleasstact your special education coordinator or
special education director. These people also qualiftefdical support from SpEd Forms.

Note: SpEd Forms Inc. ONLY provides technical support to datginSpEd Forms Administrators,
Special Education Coordinators and Special Education Dmectour school district or organizational

unit may have its own procedures. For example, mostcgecwvioperatives require questions to be directed
to the SpEd Forms Administrator.

If your district or organizational unit does not have a designated SpEd Formsisiator, please
contact your Special Education Director. Your Special Education Direetiorcontact SpEd Forms to
designate a SpEd Forms Administrator. Your SpEd Forms Administrator daasealospecial training
but should be accessible to teachers. Their role is to answer commaiogiasnd verify issues before
contacting SpEd Forms technical support.
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